Konica Minolta QuickStart Guide - Students

HOW TO PRINT
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1. Making a Copy using the PCounter Terminal
1.1

OVERVIEW
The Konica Minolta copier is configured to prevent copies from being made when the PCounter
terminal is not in “Copy mode”. When the copier is “locked down”, and the PCounter terminal is not
in Copy mode, you will see that the light around the Start button on the copier is orange, this means
that no copies can be made. Once you have followed the steps to put the PCounter terminal into
Copy mode, you will see that the light around the Start button on the copier will turn blue, which
means that you will be able to make copies.
NOTE: There are no copying facilities in lab areas, copying to be done in libraries

1.1.1 How to make a copy
In order to get the PCounter terminal into Copy mode, you will select the Copy option on the
PCounter terminal and then present your access card.
Steps:
1. On the LCD panel of the PCounter terminal, push the number 1 button to select the
1=Copy option
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2.

Once you have selected the 1=Copy option, you will be prompted to Present your Card.

3.

Place your Access Card over the Keypad as indicated in the picture to authenticate yourself.
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How to Copy a Document
On the Glass
� Place document on the glass, face down
� Close the Copier unit
� Input the amount of copies required by using the numeric keypad
� Select the start button

Through the Automatic Document Feeder (ADF)
� Place the documents in the ADF, face up
� Input the amount of copies required by using the numeric keypad
� Select the start button

Numeric keypad
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Paper size selection
� Select the Basic tab on the LCD copy panel
� Select the Paper option
� Select the required size
� Input the amount of copies required by using the numeric keypad
� Select the start button
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Double-sided Copying (Save money by printing double sided!!!!)
� Select the Basic tab on the LCD copy panel
� Select the Simplex/Duplex tab
� Select the document i.e. Single (1) or Double (2) sided
� Input the amount of copies required by using the numeric keypad
� Select the start button
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Enlarge or Reduce the document
� Select the Basic tab on the LCD copy panel
� Select the Zoom tab
� Select the predefined option or customize the options to your requirements
� Select the paper source from the specified trays
� Input the amount of copies required by using the numeric keypad
� Select the start button
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Stapling
� Select the Basic tab on the LCD copy panel
� Select the Finishing option
� Under the Finishing option selected the required stapling option
� Input the amount of copies required by using the numeric keypad
� Select the start button
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4. Once you have finished making the copies you want, press the red Finish button to
end the copy session on the PCounter terminal (else someone can use your
account to make unauthorised copies). The terminal is also configured to end the
current session automatically should you forget to press the Finish button after 3
minutes.
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2. How to Print a Document

You can print a document by using one of the following print command options:
Clicking Print
OR

on the Standard toolbar.

Clicking Print
under the File menu.
OR
Hold the “Ctrl” and “P” keys down simultaneously on your keyboard.
The Print window, similar to the one below, will appear on your screen.

*Ensure that your printer name (XXX in the slide) matches the option below for either Black/White or
Colour.
Click the “OK” button for printing to commence.
APK-Student- B&W
APK-Student-Colour
APK will be replaced at each campus as follows:
Auckland Park Kingsway

-

APK

Auckland Park Bunting Road

-

APB

Doornfontein Campus

-

DFC

Soweto Campus

-

SWC
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Printing a Print Job to a Konica Minolta Printer
When you send a print job to the printer from the Lab & Library student areas, the Print Popup will appear.
The Print Popup is used to identify who is printing, in this case you have to enter your student number as
user name and your normal network password, and these credentials will be the same as used for the
Student Portal. When you have entered you credentials you simply select print, your job will be sent to the
printer server and you can follow the same instructions on how to release a print job using a Pcounter
Terminal at a Konica Minolta device in the student areas. You can collect your print job from any
Black/White or Colour device (dependant on which driver was selected) in student areas on all
campuses within 24 hours, after 24 hours the job will be deleted if not collected.
Below is an example of the Popup:

Avoid the long print queues at Cash
Kiosks; use the WebPay system to
electronically transfer funds to your print
account, using any Web Browser from a
PC or cell phone:
https://uj.pcounterwebpay.com
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Releasing a Print Job using a PCounter Terminal
3.1

Overview
Secure print release ensures that all print jobs are tracked and billed to your print account, and that
no print jobs are lost or taken from the printer by an unauthorised person. The PCounter server,
through which the user prints, holds the print job until the user physically goes to the printer’s
terminal and presents their access card and selects the prints they want to release. The user will
only be able to release those jobs that are associated with his/her user name. Once the print jobs
have been released, they are removed from the print queue, tracked and billed to the user’s print
account.

3.1.1

How to release a print job
To release the print job, select the Print option on the PCounter terminal, present your access
card, select the prints jobs you want to release and then print them.
Steps:
1. On the LCD panel of the PCounter terminal, push the number 2 button to select the
2=Print option

2.

Once you have selected the 2=Print option, you will be prompted to Present your Card.
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3.

Place your Access Card over the Keypad as indicated in the picture to authenticate yourself.

4.

If the Access Card is valid and the user associated with the ID has print jobs waiting in his/her job
queue, those jobs will be displayed on the LCD panel of the PCounter terminal. The following
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information will be displayed on the LCD panel for each job: The document name, a unique ID for
the job, the number of pages the job consists of and the cost for the job.
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5.

If there is more than one print job associated with your user name you will be able to scroll through
these print jobs using the arrow buttons. Push the down arrow button to go to the next print job and
push the up arrow button to go back to the previous print job. If you would like to go to the
beginning of your print job list, press the . button in the middle of the two arrow buttons.

6.

To select a single print job, navigate to the desired print job using the up and down arrow buttons,
and then press the green Enter/Yes button.
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7.

You will then be given the choice to either print the selected job, or delete it. To print the selected
job, press the number 1 button to select the 1=Print option. To delete the selected job, press the
number 2 button to select the 2=Delete option. If you have any more print jobs waiting, you will be
returned to the print job list. If you have no more print jobs waiting, a message will be displayed
and your session on the terminal will be ended.
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8.

If you would like to release all your print jobs, simply press the blue Function button while viewing
any job in your print job list and then press the green Enter/Yes button to confirm that you want to
release all your print jobs.

9.

To print out all jobs, Press the Green Yes button.
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Printer Driver
Printer:
Name:
The Menu dropdown list provides a list of all the installed printers on your particular PC.
The default printer’s name appears automatically in the list and should you not select an alternative printer all
jobs will be printed to this printer.
Properties:
The properties tab indicates available options associated with the selected printer driver.
Status:
Indicates the current status of the selected printer.
Type:
Description of the selected printer.
Where:
Location or IP address of the selected printer.
Comments:
Any additional information that is included in the printer driver during installation.

Page range
Provides instructions of the portions of the document you want to print.
All:
Selecting the “All” radio button, all the pages within the document will print.
Current page:
Selecting this radio button, only the current active page in the document will print.
Pages:
Selecting this radio button will allow you to specify the pages from the active document you wish to print.

Copies
Number of copies:
Amend the numeric value or use the arrows to indicate the number of copies you wish to have printed of
the active document or page(s).
Collate check box:
By selecting the check box, multiple copies of a document with print out in numerical order. If the check
box is not selected each page will print out the required copies amount.

Zoom
Pages per sheet:
Reduction of two or more pages (max of 16 pages) to print on a single page.
Scale to paper size:
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Allows you to choose the paper size the document should print out on.
This can differ from the actual size of the document.

General
Print What:
Select the information required to be printed.
Print:
Select the order of printing.
Options:
Further general options.
OK:
Indicates that all changes have been made and will begin the print process.
Cancel:
All amendments will be cancelled and the print process will not start.
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Printing Options

Depending on the finishing options installed on your Konica Minolta printer, there are a number of
features that can be applied to the printed document to reduce paper and time wastage.

Selecting Advanced Features:
Activate the Print Window by one of the three options:
Clicking Print

on the Standard toolbar.
OR

Clicking Print

under the File menu.
OR
Hold the “Ctrl” and “P” keys down simultaneously on your keyboard.
Select the Konica Minolta printer from the printer dropdown list.
Click on the “PROPERTIES” tab to activate the printer properties windows.

Printer Properties:
Basic:
Indicates features pertaining to how the document should be printed and what additional features should be
included to the document.
Layout:
Allows the user to select finishing options and enables advanced printing features.
Quality:
You can set the quality of your print and choose to print your document in colour or black & white.
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Printer Properties

Basic:
Indicates features pertaining to how the document should be printed and what additional features should
be included to the document.
Layout:
Allows the user to select finishing options and enables advanced printing features.
Quality:
You can set the quality of your print and choose to print your document in colour or black & white.
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Printing on A4 or A3 paper
Under the Basic tab, select the Original Size from the drop down list the Size of paper you wish to print
on. A4 or A3.

Note: When choosing a different paper size you have to select a paper source at which that
specific paper is sitting in. By default this section will correspond to the document page setting.
1. Select the Konica Minolta Printer from the printer dropdown list.
2. Click on the Properties tab.
3. Select the “Basic” tab.
4. Select the “Paper Size” setting.
5. Select the paper size your required.
Under the “Paper Tray” section, select your Paper Tray Source.
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6. Select the “OK” tab to confirm selection.
7. Select the “OK” tab to start the print process.
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Printing a Document Landscape or Portrait

Portrait

Landscape

7. Select the Konica Minolta Printer from the printer dropdown list.
8. Click on the Properties tab.
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9. Select the “Basic” tab.
10. Select the “Orientation” tab and change your Orientation.
11. Select the “OK” tab to confirm selection.
12. Select the “OK” tab to start the print process.

Print Multiple Pages on One Sheet
Page per sheet
N-up is the reduction of two or more pages (max of 16 pages) to fit on a single page.
Under the “Layout” tab and then select the “Combination”. Select Layout and change your
pages per sheet.
i.e. 2-up will print 2 pages of a document onto one single printed page.
• A minimum of 2 pages up to a maximum of 16 pages can be reduced to 1 A4 page.



If you have 32 pages in your document and you select 16 up the output will be 2 x A4 pages with
16 reduced pages on each A4 page.

1. Activate the Print window.
2. Select the Konica Minolta Printer from the printer dropdown list.
3. Click on the Properties tab.
4. Select the “Layout” tab.
5. Select “Combination “, then the required option from the “Combination” menu.
6. Select “OK” tab to confirm selection.
7. Select “OK” tab to start the print process.
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Print on Both Sides of the Paper Double Sided (Find out if default???)
The ability to print on both sides of a single paper, two pages are printed on a single page,
reducing paper wastage.
This option is only available if a Duplex finishing option is installed with the printer and only works
with documents consisting of 2 or more pages.

1. Activate the Print window.
2. Select the Konica Minolta Printer from the printer dropdown list.
3. Click on the Properties tab.
4. Select the “Layout” tab.
5. Select the required option from the “Print Type” tab.
6. Select “OK” tab to confirm selection.
7. Select “OK” tab to start the print process.
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Binding Position
Document retains it’s original size and pages are printed on both sides.
Top Binding Pages print in continuous form, similar to a notepad.
Left Binding Pages are printed from side to side, similar to a reading book.

1. Activate the Print window.
2. Select the Konica Minolta Printer from the printer dropdown list.
3. Click on the Properties tab.
4. Select the “Layout” tab.
5. Select the required option from the “Binding Position” tab. Select your Duplex type from this option.
6. Select “OK” tab to confirm selection.
7. Select “OK” tab to start the print process.
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Sorted and Unsorting a Document
Collate:
When printing multiple copies of a multi page document, this feature will print the entire document in
chronological order before printing the next set of copies.

Uncollated:
When printing multiple copies of a multi page document, this feature will print the document in sets e.g. all
page 1’s then all page 2’s and so on.

1. Select the Konica Minolta Printer from the printer dropdown list.
2. Click on the Properties tab.
3. Select the “Basic” tab.
4. Select the Collate Option.
5. Select the “OK” tab to confirm selection.
6. Select the “OK” tab to start the print process.
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Stapling (if finishing option is installed – confirm???)
Click on the drop down tab will allow you to view and select the type of stapling installed on your particular
device. Below are some of the options that are available on this model type.
1 Staple The copier automatically chooses a Left Top corner point staple.
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1. Select the Konica Minolta Printer from the printer dropdown list.
2. Click on the Properties tab.
3. Select the “Finish” tab.
4. Select the “Staple” option, and change your stapling settings options.
5. Select the “OK” tab to confirm selection.
6. Select the “OK” tab to start the print process.

Printing from USB Stick
NOTE: To print from USB device, the PCounter Terminal needs to be unlocked in Print mode, by
selecting Print on the Terminal & presenting your access card to unlock. This feature is available in
all student areas.
Supported external memory devices
Requirements for external memory devices of this machine are as follows.
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- USB flash memory device that supports the USB (1.1/2.0) interface
- FAT32-formatted memory device

Connecting the external memory device
-Use the USB connector on the side that is near the control panel. Do not use the USB connector near
the rear side because it is used for optional devices.
- Do not disconnect the external memory device while saving a document in the external memory device
or printing a document saved in the external memory device.
- Do not use the USB device (hard disk or USB hub) other than the USB flash memory device.
- Do not connect or disconnect the USB memory when the hourglass is being displayed in the control
panel while this machine is active.
- Do not disconnect the USB memory just after connecting it.
- Connect the external memory device to the USB connector on the side of the machine.

When the external memory device is connected, an icon appears at the bottom of the screen, and the
screen below is displayed. Select the intended purpose, in this case “Print a document from external
memory”. (When not using the external memory, select [Close].)

External memory screen
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Entering a file path
In the touch panel, you can specify the file path to the folder containing the document to be printed.
Press [File Path], and enter the file path.
Reference
- Make sure that the total length of the file path and file name do not exceed 250 characters. If the number
of characters exceeds the limit, the file list is not displayed.
Selecting a file
You can print the following file document types: PDF, JPEG, TIFF, and XPS. Select a document of one of
these types from the list. You cannot print Bitmap or Microsoft Office documents such as Word or Excel.
Reference
- 2-sided printing – should be default, punching, or stapling is not supported for JPEG and XPS files.
- Printing is not possible when printing is restricted by Security Settings of a PDF file.
- This machine supports printing of PDF Version 1.6 or earlier. - Greg clarify
- Only the files of printable file types are displayed in the list.
- File access fails when the total length of the file path and file name exceeds 250 characters.
- Up to 200 printable files are displayed in the folder of the specified file path. If the folder contains 200
or more files, it may take time to display the file list screen.
Printing encrypted PDF data
To print the encrypted PDF data saved in the external memory device, select the data in the External
Memory screen and print the data. When the print command is issued, the encrypted PDF data in the
external memory is saved in the Password Encrypted PDF User Box of this machine. Access the Password
Encrypted PDF User Box of this machine, and then print the data.
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3. Scanning

4.1

Scan to email

1. Place the document to be scanned on the glass or the ADF of the machine.
2. Select the Fax/Scan option on the control panel of the machine.

(The Control Panel screen will change from the Copy Panel to the Scan Panel).

3. Select the Direct Input Tab and enter your email address
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Scan Settings
Select Scan Settings on the bottom of the screen. These settings allow the users to determine output
attributes of the scanned document.

Scanning attributes that can be modified are:
 Original Type
 Simplex / Duplex
 Resolution
 File Type
 Density
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7. Once you are ready to start scanning Press the Green Start Button on the device to start the scan
process.
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Scanning to USB
Saving a scanned document to external memory (USB Stick)

1 Connect external memory to the machine, and press [Save a document to external memory.].

If an external memory is already connected, press [Save Document] on the screen for User Box function.*

2

Check the document name.
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-The document name can be changed when saving a document.

3 Once you are ready to start scanning Press the Green Start Button on the device to start the scan
process.

*Although the “Print from external memory” option is available without authenticating for scanning, when trying to print from external
memory an “insufficient funds” error will be displayed. Unlock the PCounter Terminal in Print Mode before printing from external
memory to avoid this error.
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4. WebPay
Features:


Extremely easy to use



100% automated



Immediate print fund availability



No queuing at ATM’s and Cash Kiosks



Parents & benefactors can upload funds to student accounts



Used to pay for print & finishing costs



Use Web Browser from PC, or your cell phone to upload funds



All transaction receipts are emailed to student

The safe, easy and inexpensive way to deposit print funds to your account

Using any Web Browser from a PC or cell phone, visit the UJ WebPay interface at :
https://uj.pcounterwebpay.com
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Enter your login credentials
(Username=Student Number)

Choose deposit option and select amount to upload
(Minimum R25.00 & maximum R350.00)
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Confirmation screen 1

Confirmation screen 2
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Student is presented with payment screen relevant to available payment methods (VISA, MasterCard
etc)

If payD was selected for other payment methods:
Screen 1
(Vodacom/MTN only – can also send request to a friend’s Vodacom/MTN cell to complete request)
For alternate debit card payments, students can load funds from their debit card using the credit/debit
card machine by the Cask Kiosk, take the confirmation slip to an OPS staff member to deposit the funds
into the student’s print account with WebCashier
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Payment confirmation screen

5. Cash Kiosks

Students with cash only, can walk up to a Cash Kiosk facility, and load funds to their account
The student presents their student card at the cash kiosk.
The student is authenticated and their current balance is displayed on the screen.
The student can then insert coins and notes into the autoloader.
As the student inserts coins or notes, their new balance will be displayed on the screen.
The student then presses the ‘Finish’ button to complete the transaction.
The new student balance is immediately available for use.
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